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Parent-level Custom Questions
To allow agencies to collect information that is relevant at the family/parent level, agency users can now add custom
questions directly to the parent/guardian section on a registration form. For example:

* A question that is relevant only when asking a parent/guardian, such as “Do you have children that require
daycare assistance during the session?”.

* A question that applies to all participants under a family and thus only needs to be answered once, such as
“Is your family eligible for financial aid?”.

Adding Parent-level Custom Questions

To add parent-level custom questions to a season’s registration form (AUl > Home tab > a season > Setup >
Registration forms > Customize registration form), click the Parent/Guardian questions section > new Add form
element dropdown > Custom question option.

Home People Finance Emall Membership Add-ons
Step 6: Registration forms Status: Active
Set up the questions and forms you need to get a participant ready for camp.

— Information required to complete initial registration.

Online registration form and waivers Settings

Reglstration form

AR GGG RE T -
??ﬂ\ctP5l1-ﬂPi=!|°"a Customize registration form |

Parent questions ?
oot 5 quest Viev . Registration forms

Electronlc walvers 2

No custom electronic walvers added.
Add

Examples: Photo/Video permissions, Liability waivers Frequently asked questions
o Participant photo and supplemental forms
J = Collected after initial registration through the online account.
Participant photos ?

¥| Require registrants to upload a photo




Customize Registration Forms

Select, edit, and order the participant and parent/guardian questions you would like to include on the registration form for this season.

Porticipant questions

These are the questions that will be asked about people being ragistered.

* First name

* Last name # Edit

Parent/Guardian questions

These are the questions that will be asked of the person entering the registration Custom question
Subheader
* First name
Text hlock
* Last name

Gender Male . mw_J

Female # Edit

* Date of hirth &

# Edit

Similar to the existing participant-level custom question feature, on the Add custom question popup, agency users

can select questions from existing custom questions or create a new custom question and then add it to the
Parent/Guardian questions section on the registration form.

Add custom question

Custom questions library Can't find the question you're looking for?

7 Create a custom question

L) test of dropdown question
Multiple choice - choose one View answer choices | Delete

* Question

) can you do the splits ?
Mulfiple choice - choose one

View answer choices | Delete * Question type Selectatype

(=] -
| Do you have any medical conditions? Do not auto-fill this question
Mutii b nany

View answer choices | Delete

Do you need childcare service during this session?
Muitiple choice - choose one View answer choices | Delete

Is your family eligible for financial aid?
Muliple choice - choose one View answer choices | Delete

Do you have a family-discount (for registering more than 2 people)?
ne View answer choices | Delete

! Do you need pickup service for your kids?
e one

Multiple choice View answer choices | Delete




Agency users can also permanently delete a parent-level custom question from the question library by clicking
Delete on the Add custom question popup (note: if a question is being used in any registration forms or follow-up
forms, then users must remove the question from all these forms before deleting it from the library).

Add custom question

Custom questions library Can't find the question you're looking for?

~  Create a custom question

| test of dropdown question

View answer choices | Delete

* Question

Can you do the splits ?
Muttiple choice - choose one View answer choices | Delete * Question type Selectatype

Do you have any medical conditions? =)' Do not auto-fill this question

e ch e many View answer choices | Delete

Do you need childcare service during this session?

View answer choices

—1"Is your family eligible for financial aid?

hoice View answer choices | Delete

Do you have a family-discount (for registering more than 2 people)?
Auitiple choice se one View answer choices | Delete

Do you need pickup service for your kids?

h View answer choices | D

After a question is added, agency users can then drag-and-drop the question to its required location (within the
Parent/Guardian questions section).

Parent/Guardian questions

These are the questions that will be asked of the person entering the registration.

* First name
* Last name # Edit
ender Male \iBemove)
Female # Edit
Do you need childcare service Yes | Remove |
during this session?
No # Edit
Dispiays for all ses:

* Date of birth

@

# Edit

Similar to the existing participant-level custom question feature, to edit the details, session applicability, display
condition or translation information of a parent-level custom question, click Edit to open the Custom questions
popup.

Do you need childcare service
during this session?

| Remove |

Yes

o




Custom questions

Edit custom question

Details Session applicahility Condition Translation

* Question Do you need childcare service during this session?

* Question type Multiple choice - choose one

* Display ®  Radio button
Recommended for less than 4 choices
' Dropdown
Recommended for 4 or more choices
* Choices T ves
1 No

Add another choice

* Report label Do you need childcare service during this session?

Instructional text

Note: By default, a parent-level custom question is displayed in all sessions in this season. If a question only needs to
be displayed in specific sessions, then select the required sessions under the Custom questions popup > Session

applicability tab.

To hide a parent-level custom question from the registration form, click Remove.

Do you need childcare service Yes

during this session?
# Edit

No

or all sessions

Displays

After saving the configuration, parent-level custom questions are listed on the season setup > Registration forms
Online registration form and waivers section > Parent questions > View > Parent questions popup:

Home People Finance Emall Membership Add-ons

Step 7: Registration forms Status: Active

Settings

Set up the questions and forms you need to get a participant ready for camp.

Online regi ion form and wai
Information required to complete initial registration.

Reglstration form

5 2
E’amclpan! qureraﬂioﬂir | Customize registration form |

estlons estions  View

Parent questions ?

Registration forms

Electronic walvers 2

No custom electronic walvers added.
Examples: Photo/Video permissions, Liability walvers [ Add |
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These are the questions currently being asked during registration.

Name (required)
Gender

Date of birth (required)
Email address (required)

Home phone number

Do you need childcare service during this session?
Is your family eligible for financial aid?
Do you have a family-discount (for registering more than 2 people)?

Do you need pickup service for your Kids?

When copying a season that has parent-level custom questions, the questions are also copied to the new season.

AUI: Display of Parent-level Custom Questions
Parent-level custom questions are displayed in the AUl Front Desk Registration (FDR) workflow and relevant reports:

Parent-level custom questions are displayed in the Register someone > required session > Answer questions tab >
Parent/guardian information section:

Register Jimmy White Summer 2020 Baske...

Total
Summer 2020 Basketball Jimmy White

Basketball Week 1
Select sessions Answer questions

Participant information

$126.00
* Firstname Jimmy
Lastname. White
Gender ® Male

-ttt g oL St N b i -

Parent/guardian information

Primary parentiguardian

First name Kathy

* Last name whie
Gender Male

® Female

Date of birth 121811981

* Emall eddress 17903033748qa.com
Home phone number 1044321234
Do you need childcare ves
service durng this session? No
I your family eligible for ves
finencial aid? No
Do you have & family-discount ves
(for registening more than No
people
Do you need pickup service s
for your kide? o

4 _Add secondary parent




After registration, agency users can change the answer to a parent-level custom question by clicking People tab >
required participant > View > Forms section > Registration forms tab > Edit and then editing the answer to the
required question.

Credit balance info White family

$508.00
Available credit ~Send emall | | Register | _ Download financlal statement

my White waie, Age 14, 00B: 1211812005 Family participants

Current seasons u Jimmy White
Buy membership | | Authorized pickup | u June White
Add photo Female, Age 14

Contact Information

Kathy White
Primary parent

home: 404-43

Summer 2020 Basketball Season balance
Home = People = Jimmy White = Summer 2020 Basketball
$44750
Jimmy White Famty

Male | Ages14

Make payment Send email Run reg form report Buy membership il
Waivers

Use permit3

Use permit

Registrations and attendance

Use permit 2

Registration information and attendance tracking for sessions in this season.

Parent information

Kathy White

Actions = Basketball Week 1 $°.Oo -
06/01/2020 - 06/06/2020 Bal
Inncvation Tower slance
Tuition
Price - $108.00

Sesslon options
Pickup service - $10.00

Forms

Reglstration forms

First name Jimmy

Last name White

Gender Male

Date of birth 12/18/2005
Emall address kjiang@one com
Home phone number 404.434.1234
Address 123 test dr.

United States, NE 12345




Finance Emall Membership Add-ons Ql

Edit registration answers

Participant information

First name Jimmy

Last name White

Gender ® Male
Female

WJWJMM.-’*"MJ‘

Parent/guardian information

Primary parent/guardian

First name Kathy
Last name White
Gender Male

® Female
Date of birth 12/181981
Emall address 17903033748qq.com
Home phone number 1044341234
Do you need childcare ® Yes
service during this sesslon? Mo
I your family eligible for Yeo
financial ald? ® MNo
Do you have a family-discount Yes
(for registering more than 2 Mo
people)?
Do you need pickup service Yes
for your kigs? No

¢ Add secondary parent

Segment report:

When exporting a segment report (People tab > Segments section > All segments > required segment > Export
report button), agency users can now add parent-level custom questions (listed under the Choose columns popup >
Available columns) as exported columns in the report.

Choose columns

Participant: what kind of DIke G0 y...
Participant: Name

Participant: why do you like biking st
ge today

Primary P/G: Do you have a family...
Participant: Home phone number

Primary P/G: Do you need childcar.. (
Participant: Emall address

Primary P/G: Do you need pickup
Primary P/G: Name [

A
v

Primary P/G: Emall address
Participant: Address

Primary P/G: Home phone number
Participant: City

Primary P/G: Is your family eligible..
Participant: Gender

Secondary P/G: Do you have a fa.

Secondary P/G: Do you need child.. v

Reset to default Add & blank column Column label

(B [ save and download report




Registration form report:

In the PDF-formatted registration form report (Home tab > a season > Reports > Registration form report), if the
Select sessions popup > Registration form questions checkbox is checked, then parent-level custom questions are
included in the report.

Select one or more sessions to view in this report.

Q

4" Name S ‘Dne ‘quum ‘Lo:mon

¥  Basketball Week 1 06/01/2020 - 06/06/20. 1 Innovation Tower

Include in report IJ Registration form q¢esumsl |¥| Suppiemental forms

|#| Authorized pickup |#] Waivers

=N

Basketball Week 1

Jimmy White
06/01/2020 - 06/06/2020 Age 14 as of 06/01/2020
Innovation Tower, Hong Kong, Hong Kong

Selections Reg #: 26312402

Balance: $0.00

Reg Date: 10/28/2019
Status: Confirmed
Dosha: Not assigned

Item Total
Price o | s108.00
Pickup service | $10.00
Lunch | $8.00

Parent/Guardian Information

Primary Parent/Guardian
Name: Kathy White
Gender: Female
Date of birth: 12/18/1981
Email address: 1790303374@qq.com
Home phone number: 404-434-1234

Do you need childcare service
during this session?:

Is your family eligible for
financial aid?:

Do you have a family-
discount (for registering
more than 2 people)?:

Do you need pickup service
for your kids?:

Participant Information

Name: Jimmy White
Gender: Male

Date of birth: 12/18/2005
Email address: kjiang@one.com
Home phone number: 404-434-1234

Address: 123 test dr.
United States, NE 12345
United States

Tell us about yourself briefly:




Custom season reports:

When creating custom reports (Home tab > a season > Reports > an existing custom report or New custom report),
agency users can now filter results by parent-level custom questions (listed under + Edit filter criteria > Registration

guestion > the Select a form question dropdown) or add parent-level custom questions as columns in a report
(listed under Customize > Edit columns > Available columns).

Set the filters you want for your report

) Registration date (UTC) MMDDYYYY | toMM/DD/YYYY

Session option
Merchandise

J Tution

¢| Registration question Select a form guestion

Select a form question

Reglstration balance Participant: Emall address

Participant: Tell us about yourself briefly

—! Registration status Participant: Gender

Primary P/G: Emall address

Primary P/G: Gender

Primary P/G: Do you need childcare service during this session?
Primary P/G: Is your family eligible for financial aid?

Primary P/G: Do you have a family-discount (for reglistering more than 2 people)?
Primary P/G: Do you nead plckup service for your kids?

Yy PG,

Secondary P/G: Gender

Secondary P/G: Do you need childcare service during this session?

Secondary P/G: Is your family eligible for financial ald?

Secondary P/G: Do you have a family-discount {for registering more than 2 people)?
Secondary P/G: Do you need pickup service for your kids?

Searchforac earch for a column

b

Primary P/G: Date of birth L Participant: Name

Primary P/G: Do you have a family... Ll Participant: Gender

Primary P/G: Do you need childcar... LI Primary P/G: Name

Primary P/G: Do you need pickup ... ] &l Sessionname

>
Primary P/G: Emall address 1 | | L) Participant: Age as of today

Primary P/G: First name Il Balence
[l Prmary P/G: Gender

| Primary P/G: Home phone number

I‘J Primary P/G: Is your family eligible...

Reset to default Add a blank column Column label

11



CUI: Display of Parent-level Custom Questions

Parent-level custom questions are displayed in the CUI session registration workflow:

CUl:

Location: a session > ADD TO CART > CONTINUE > log in > Registration Information > Your Information section

Desktop

Sattvic Retreats

Registration Information

COMPLETE THE FOLLOWING INFORMATION TO REGISTER

1 | ENTER YOUR EMAIL ADDRESS

Q Kathy White

17903033

2 | PARTICIPANTS & OPTIONS

Add sessions

@ Tracy White s X

Basketball Week 1

Subtotal: $108.00

Price $108.00

3 REGISTRATION FORMS

Your Information

First name Kathy

Last name White

Gender Male
© Female

Date of birth 12/18/1981

Email address

Home phone number

4044341234

childcare

during this sess

/e a family- Yes

1ore than

) SECURE ONLINE REGISTRATION

HAVE QUESTIONS?

Basketball Week 1 contact

. 1-800-123-1234

=4 public@public.com

— '«»&I""‘“\.

Mobile

Your Information
First name

Kathy
Last name

White

Gender

O Male
Q remale

Date of birth

Email address

1790303374@qq.com

Home phone number

4044341234

Do you need childcare service during this
session?

QO Yes

O No

Is your family eligible for financial aid?

O Yes

@ No

Do you have a family-discount (for registering
more than 2 people)?

Q Yes

O No

Do you need pickup service for your kids?

12



Color Scheme Customization
To allow agencies to configure their consumer websites with an attractive color scheme that is consistent with their
branding, ACTIVE administrators can now turn on the Color customization feature for agency users to customize the

CUlI color schemes at both agency and season levels.

Enabling Color Customization Feature
Location: Settings > Advanced settings > Color customization switch (defaults to ON)

Home People Finance Emall Membership Add-ons

Advanced settings

Attendance tracking «

Enable attendance tracking for this agency
Allow coaches to log and monitor participant attendance and email participants with repeated absences.

" Tracking mode Check-In & Check-out ¥

Y| Advanced features
Enable authorized drop-off & pick-up persons and require drop-off & pick-up persons'
signatures

Cart abandonment data collection [ @) Advanced settings

Enable Cart abandonment data collection for this agency

Store information about customers who abandon their purchase and be able to follow-up with an email or discount opportunity.

ICoIor customization

( )I Frequently asked questions

Enable color customization for this agency

Allow agency users to customize color scheme of their consumer websites.

Notes:

The agency-level color scheme applies to ALL seasons including existing CUI color display. Users can
configure the color scheme for a particular season that overrides the agency-level colors.

Customized color scheme affects the CUI Session selection page, SESSION INFORMATION popup and
Calendar view, but does not affect the CUl home page (Programs list page).

After agency users have configured their agency-level and season-level color schemes, if this switch is
turned off, then the color schemes will reset to the default ACTIVE color scheme.

When copying a season/session with a customized color scheme, the color scheme configuration is also
copied to the new season/session.

This feature is not available on CCM Lite.

13



Customizing Agency-level Color Scheme

Once the Color customization switch is turned on, a Customize color button appears on the Settings > Organization

branding page. Agency users can customize the overall color scheme of their consumer websites by clicking this

button. Users may also choose to use the default ACTIVE color scheme at the agency-level and only change colors for

a particular season.

Organization branding

| Change background image | | Change logo

|

Customize color

Season list

Customer account page

ACTIVE

Sattvic Retreats

e

Hide ACTIVE branding on registration form.

Use agency branding on financial statement.

Customize the appearance of your consumer websites where your customers purchase and manage registrations

Settings

Organization branding

Frequently asked questions

14



On the Organization branding page, since the uploaded logo and background image also apply to the CUI season-list
page, a Season list template is now displayed for review (note: color scheme changes are not displayed for review in
the Season list template).

Clicking the Customize color button opens the Custom color popup (defaults to the ACTIVE color scheme). Agency
users can change the primary, secondary, shopping cart header, button text and shopping cart header text colors in
their CUI websites by entering the required Hex color code or selecting a color in the color picker (users may use the
color picker to check the equivalent Hex or RGB value and then edit as required).

©

A\ Piease preview the color scheme in the season setup (the "Look and fee

Text and buttons Hex color code
* Primary coler # a3 :2 ‘g

* Secondary color

* Button text/Tab text/Tag text

Shopping cart header

* Background

([ Resettodefault ||

To reset to the default ACTIVE color scheme, click Reset to default.

After saving the agency-level color scheme, users can preview the effect in the Home tab > any season > Setup >
Look and feel step:

Step 5: Look and feel Status: Active

Settings

Customize the appearance of the account your customers will use to manage their registrations.

| Change background image | | Customize header | | Customize color |

» .

Sattvic Retreats

Look and feel

Frequently asked questions

15



Note: Users can click Show tips to see a visual definition of the primary color, secondary color and shopping cart

color.

ACTIVE
J = ! . J :

T ~

@ Show tips

Sattvic Retreats 5

."‘

Step 5: Look and feel

Customize the appearance of the account your customers will use to manage their registrations.

| Change background image | | Customize header | | Customize color |

X Close tips

Look and feel

Status: Active

Settings

Look and feel

Frequently asked questions

Users can then review color changes on the CUI Session selection page, SESSION INFORMATION popup and

Calendar view.

16



Customizing Season-level Color Scheme
Once the Color customization switch is turned on, a Customize color button also appears on the Home tab > a
season > Setup > Look and feel page. Agency users can configure a season-level color scheme by clicking this button.

Membership Add-ons

Step 6: Look and feel Status: Active

|  Change backgroundimage | | Customize header \l\ Customize color || Settings

ACTIVE

= e TN e —

@ Show tips L

Customize the appearance of the account your customers will use to manage their registrations.

Sativic Retreats

Look and feel

On the Custom color popup (by default, the color scheme inherits the agency-level color scheme), agency users can
customize the primary, secondary, shopping cart header, button text and shopping cart header text colors that apply
only to this season. This configuration will override the agency-level color scheme.

To reset to the agency-level color scheme, click Reset to default.

Text and buttons

* Primary color

' Secondary color

' Button text/Tab text/Tag text

Shopping cart header

* Background

Reset to default

17



After saving the configuration, users can preview the season-level color scheme in the Look and feel step:

Step 6: Look and feel

Status: Active

See a preview
Customize the appearance of the account your customers will use to manage their registrations

| Change backgroundimage | | Customize header | | Customize color |

Settings

ACTIVE

© Show tips
Sattvic Retreats (

Look and feel

Frequently asked questions

CUI: Display of Customized Color Scheme
By default, the CUI sites display the default ACTIVE color scheme. Once agency users have configured and saved their

customized color schemes, the configurations are then applied to both the normal and session-group CUI workflows
on the following pages and popup:

Session selection page:

Desktop Mobile

. X ACTIVE | Sattvic Retreat:
Sattvic Retreats | Sattvic Retreats

SIGN IN English (United Stat... »

Sattvic Retreats

. . WES R 4
Session Selection o
SELECT YOUR SESSION BELOW. YOU CAN REGISTER MULTIPLE PEOPLE AT THE SAME TIME. \1"\.(\"
FILTER BY w CALENDAR 'E YOUR SHOPPING CART ¥ Filter 7 Your cart
LOCATION N Basketball Week 1 You have no sessions selected
2 Get started by adding a session on the Session Selection
All locations v View more details left

® 202 202 Basketball Week 1
SESSION TYPE v @ Innovation Tower View more details
RN Discounts avallable >

®© 06/01/2020 - 06/06/2020

9 Innovation Tower
Price $54.00
Deposit required at checkout

£ SECURE ONLINE REGISTRATION Deposit required at checkout

‘B ADD TO CART

HAVE QUESTIONS?

Agency primary contact

L, 1-800-123-1234

&4 public@public.com

18



SESSION INFORMATION popup (by clicking the session name, the View more details link or the discount tag (if

available)):

Desktop
SESSION INFORMATION X
Basketball Week 1 -

9

$27.00 off when you register 2 people

Price $54.00 'R ADD TO CART

Deposit required at checkout

Session Options

(Optional items chosen later in registration)
laundry service $5.00

extra-lunch box $10.00

Calendar view (desktop only):

Mobile

X ACTIVE | Sattvic Retreats

SESSION INFORMATION X

Basketball Week 1

2020 - 06/06/2020

$27.00 off when you register 2 people

Price ss4.00 [EEE

Deposit required at checkout

Session Options

(Optional items chosen later in registration)
laundry service $5.00

extra-lunch box $10.00

Session Selection

FILTER BY SESSION LIST

LOCATION A MONTH DAY

All locations Y -
izl < June 2020 =115
SUN MON TUE WED THU FRI SAT

SESSION TYPE v 1 2 3 4 5 6

Basketball Week 1

7 8 9 10 11 12 13
14 15 16 17 18 19 20
21 22 23 24 25 26 27
28 29 30

SELECT YOUR SESSION BELOW. YOU CAN REGISTER MULTIPLE PEOPLE AT THE SAME Tl

You have no sessions selected
Get started by adding a session on the
left

{3 SECURE ONLINE REGISTRATION

HAVE QUESTIONS?

Agency primary contact

. 1-800-123-1234

% public@public.com

19



For improved usability, search filters on the CUI session selection page are now collapsible:

Session Selection

SELECT ONE OR MORE SESSIONS BELOW. YOU CAN REGISTER MULTIPLE PEOPLE AT THE SAME TIME

View more details

9 Innovation Tower

E YOUR SHOPPING CART

You have no sessions selected
Get started by adding a session on the

[¢CEIl W ADD TO CART

FILTER BY SESSION LIST CALENDAR
LOCATION A Advanced-Yoga &
All locations v View more details
o© - 01/30/2021
DATES v 9 White Heaven Beach
AGE v o
[[] Adult tuition
GRADE - 20192020 v [Tl Discount tuition (age
<25 or >55)
SESSION TYPE v
Session 4

left

$550.00

$400.00

£ SECURE ONLINE REGISTRATION

HAVE QUESTIONS?

Agency primary contact

. 1-800-123-1234

4 public@public.com

Yona 2019-2020 contact

Session-specific Deposits
Session-specific deposit information is now included in the season setup auditing report (Home tab > a season >
Reports > Season setup auditing report):

When a season deposit is changed to or from session-specific deposits, it is listed as Deposit: Change initial
deposit amount in the Type of change column, and blank in the Name of changed item column.

In the Previous value and Final value columns:

If the value is a session-specific deposit, then it is listed as Different deposit amounts for different

sessions.

If the value is different from any session-specific deposits, then existing rules of previous and final values
are applied (for example, Pay deposit of 510 or check out without making any payment).

A B = D E F

q= Name of changed itRd Previous value ﬂ Final value B4 pate of change (UTC) ﬂ User

2 |Deposit: Chang deposite option available 08/15/2020 01/15/2020 12/09/20199:00:22 AM  Waiver001 Test002
3 |Deposit: Chang deposite option available 08/15/2019 08/15/2020 12/09/2019 8:41:04 AM__ Waiver001 Test002
4 |Deposit: Change initial deposit amount Pay deposit of $30.00 check out without mak 11/28/2019 2:51:51 AM I Waiver001 Test002
5 |Sessions: Change close registration date Z-Session 11 11/30/2018 12/31/2019 12/09/2019 8:39:08 AM  Waiver001 Test002
6 Sessions: Change close registration date Yoga for Girls! 09/30/2019 12/31/2019 12/09/2019 8:38:14 AM  Waiver001 Test002
7 |Sessions: Change close registration date Session 9 11/24/2018 12/31/2019 12/09/2019 8:37:21 AM  Waiver001 Test002
8 Sessions: Change close registration date Session 8 11/30/2018 03/14/2020 12/09/2019 8:35:55 AM  Waiver001 Test002
9 |Sessions: Change close registration date  Session 7 11/24/2018 02/15/2020 12/09/2019 8:35:20 AM  Waiver001 Test002
10 Sessions: Change close registration date Session 6 11/24/2018 02/15/2020 12/09/2019 8:32:56 AM  Waiver001 Test002
11 |Sessions: Change close registration date  Session 5 11/30/2018 01/01/2020 12/09/2019 8:32:12 AM  Waiver001 Test002
12 Sessions: Change close registration date Session 4 11/30/2018 01/31/2020 12/09/2019 8:31:33 AM  Waiver001 Test002
13 |Sessions: Change close registration date  Session 10 12/15/2018 12/31/2019 12/09/2019 8:30:35AM  Waiver001 Test002
14 |Sessions: Change close registration date nginner-Yoga 11/30/2019 12/31/2019 12/09/2019 8:30:05 AM  Waiver001 Test002

Season setup auditing report \ ® |
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